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e Finally, the Accounting format is the only built-in format that includes formatting cri-
teria for text. It includes spaces equivalent to the width of a parenthesis on each side
of text so that it too lines up evenly with the numbers in a column.

Typically, when creating a GAAP-friendly worksheet of currency values, you would use
currency symbols only in the top row and in the totals row at the bottom of each column

of numbers. This makes good sense because using dollar signs with every number would

make for a much busier table. The middle of the table is then formatted using a compatible

format without currency symbols, as shown in Figure 9-37.

A L B | c D E F G H J K L M N
1 |2013 Sales by Product
3 Jan Feb Mar Apr May Jun Jul Aug Sep Oct Nowv Dec Total
4 |Pmduct1 5 73115 6329 5 2110 § 1710 5 2984 § 1100 § 2467 5 9954 5 2315 § 6177 § 3367 5 9931 5 49175
5 |Product 2 281 2,336 1,234 6,176 1322 678 3737 1,781 5377 8,254 6.906 4,208 42,290
6 |Product3 287 4,107 5,528 8,599 9,769 5,557 3.456 4,692 1,250 4,833 4,860 9,032 61,970
7 |Product4 436 2202 5.607 8.340 5832 2,350 1.669 5,094 9.658 7479 775 1,785 51227
8 |Product5 945 3.398 3.472 4,585 3453 8.476 8.118 5796 2,920 4.840 47117 2211 52,931
9 |Product 6 781 6,982 7.018 1,885 4,336 6,394 6,989 2,038 8,336 5,546 9,805 1,250 61,360
10 |Product 7 997 7.267 5,006 6,692 8,388 9,072 8,968 5,923 7.618 1,683 4311 3,304 69,229
11 |Product 8 253 4,100 6,328 3.807 7.850 1213 5253 3.934 4,261 4,933 293 3.685 48,548
12 |Product 9 310 2467 5349 7,142 2343 2,712 4,629 3.961 1,250 2,278 7167 8,470 48,078
13 |Product 10 544 2,783 1,642 1,562 2456 5,584 1,255 7.915 2,343 1,012 869 5,862 33,867
14 |Product 11 781 8.626 6.938 5,200 8,197 6.542 5,955 1,775 221 4,688 2,309 5472 58.694
15 |Product 12 278 6,720 4754 3.556 2535 4100 4,740 7.047 9,284 4445 5633 7.557 60,649
16 |Product 13 736 3.248 7.295 4,344 2,076 8,372 1,846 1,264 34 7,764 8,649 2,249 51,584
17 |Product 14 991 5,004 6,873 7.009 8,399 4,204 8.290 2,695 1417 6,003 9,688 4,852 65425
18 |Product 15 659 8.499 1.404 1,749 5,999 4398 221 1,167 9,495 4,916 489 5015 46,001
19 |Product 16 203 5359 8.656 4,240 2,690 2211 4893 1.264 7.469 7.903 4367 1,210 50,465
20 |Product 17 73 5,814 2773 4,464 2,067 8424 1,337 1,404 7.1 5,579 4,398 6,524 50,868
21 |Product 18 183 1422 1,572 5771 6,611 9.131 9.121 1.237 9.969 2,604 9.375 1.350 58.346
22 |Product 19 153 2,938 5923 9.180 7.783 1542 2123 5953 1,336 4121 1,542 1,153 43,747
23 |Product 20 968 3,310 4472 3,065 4,700 6,384 9.079 6,995 1,642 965 7,584 5,922 54,986
24 Total $10,500 $92,911 $93,954 599,006 $99,790 $98,444 $96,136 581,889 $99,503 $96,023 $99,742 $91,362 §1,059,440
25

Figure 9-37 It is standard practice to use currency symbols only in the top and bottom rows of a

table.

Luckily, Excel makes it easy for you to format this way by using buttons in the Number
group on the Home tab. Despite seemingly incompatible button names, both the Account-
ing Number Format button and the Comma Style button apply Accounting formats adher-

ing to the rules described earlier. So, to format the numeric entries in the table shown in

Figure 9-37, select the first and last rows of numbers, click the Accounting Number Format
button, then select all the cells containing numbers in between, and click the Comma Style
button. (We then selected all the numeric cells in the table and clicked the Decrease Deci-
mal button twice to hide all the decimal values. We also hid worksheet gridlines, by clearing

the Gridlines option on the View tab, to simplify the appearance.)
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(e . . )
Using accounting underlines

Generally accepted accounting principles specify the proper usage of single and double
underlines in tables. The Underline button on the Home tab includes a menu letting
you select single or double underlines, but unfortunately these do not rise to the
accepted standard. But fear not—Excel provides two accounting-specific underline for-
mats in a drop-down list of the same name on the Font tab in the Format Cells dialog
box. These differ from their regular counterparts in two ways. First, accounting under-
lines are applied to the entire width of the cell (minus a parenthesis-sized space on
each side), whereas regular underlines are applied only under the actual characters in a
cell. If the cell contains a text entry that extends beyond the cell border, the account-
ing underlines stop at the cell border. Second, the accounting underline formats appear
near the bottom of cells, unlike regular underlines, which are applied much closer to
the numbers or text in the cell, resulting in annoying lines through commas and the
descenders of letters like g and p. Of course, you can also apply single-line and double-
line cell borders instead of underline formats, which is the approach used when you
add a totals row to a table using the Totals Row option on the Table Tools Design tab.
N\ W,

For information about font formats, see “Using fonts” later in this chapter. For information
about tables, see “Formatting tables” earlier in this chapter.

Formatting percentages

Not surprisingly, using the Percentage format displays numbers as percentages. The deci-
mal point of the formatted number, in effect, moves two places to the right, and a percent
sign appears at the end of the number. For example, if you choose a percentage format
without decimal places, the entry 0.1234 is displayed as 12%; if you select two decimal
places, the entry 0.1234 is displayed as 12.34%. Remember that you can always adjust
the number of displayed decimal places using the Increase Decimal and Decrease Decimal
buttons.

An interesting (and helpful) quirk about percentage formats is that they behave differently
depending on whether you type a number and then apply the format or type a number in
a previously formatted cell. For example, Figure 9-38 shows two cells formatted as percent-
ages. We typed the same number—22.33—in each cell, but only cell A1 was previously
formatted with the Percentage format; we clicked the Percent Style button after typing the
value in cell A2.

As you can see, it makes a world of difference which way you do this. So, why is this behav-
ior helpful? For example, if a worksheet contains a displayed value of 12% and you need
to change it to 13%, typing 13 in the cell would seem to make sense, even though this is
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technically wrong. It is not particularly intuitive to type .13 (including the leading deci-

mal point). Usability studies show that most people would type 13 in this situation, which
would logically result in a displayed value of 1300% (if not for the quirky behavior), so Excel
assumes that you want to display 13%. If you apply the Percentage format to a range of
cells that already contain values (or formulas that result in values), check all the cells after-
ward to make sure you get the intended results.

H ©- O = Book] - Excel
HOME = INSERT  PAGELAYOUT  FORMULAS  DATA  REVIEW  VIEW  DEVELOPER

% o a v = __ = -
Calibri M A A T == ’53/" = Percentage - - 7]
g - = 9 v
Paste < B I U- . fy . A . === & 3= - $ -0 s 0o Conditipnal Format as
Formatting ~ Table~
Clipboard Font ] Alignment ] Mumber ] Styles
2 - £ 2233% Percent Style (Ctrl+Shift+%)
Format as a percent.
A B C D E F G H T J S
1 22%
2 | 2233%1
3
4

Figure 9-38 When using percentages, it makes a difference whether you format before or after
typing values.

Formatting fractions

The formats in the Fraction category in the Format Cells dialog box, shown in Figure 9-39,
display fractional numbers as actual fractions rather than as decimal values. As with all
number formats, the underlying value does not change despite the displayed value of the
fraction.

You can generate some wild, nonstandard fractions unless you apply constraints using
options in the Format Cells dialog box. Here is how Excel applies different fraction formats:

e The Up To One Digit (single-digit) fraction format displays 123.456 as 123 1/2, round-
ing the display to the nearest value that can be represented as a single-digit fraction.

e The Up To Two Digits (double-digit) fraction format uses the additional precision
allowed by the format and displays 123.456 as 123 26/57.

e The Up To Three Digits (triple-digit) fraction format displays 123.456 as the even
more precise 123 57/125.

e The remaining six fraction formats specify the exact denominator you want by
rounding to the nearest equivalent—for example, displaying 123.456 using the As
Sixteenths format, or 123 7/16.
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Mumber Alignmentl Font |Border| Fill |Protection

Categony:

General Sample
Number 123172
Currency
Accounting Type:

Date ~
Percentage Up to two digits (21/25)
Up to three digits (312/943)
As halves [1/2)
As quarters (2/4)
As eighths (4/8)
As sixteenths (8/16)

Scientific
Texut
Special
Custom

Figure 9-39 Excel provides many fraction-formatting options.

You can also apply fraction formatting on the fly by typing fractional values in a specific way.
Type a number (or a zero), type a space, and then type the fraction, as in 123 1/2. For more
details, see “Formatting as you type” earlier in this chapter.

Formatting Scientific (exponential) values

The Scientific format displays numbers in exponential notation. For example, a two-decimal
Scientific format (the default) displays the number 98765432198 as 9.88E+10 in a standard-
width cell. The number 9.88E+10 is 9.88 times 10 to the 10th power. The symbol E stands
for exponent, a synonym here for 10 to the nth power. The expression “10 to the 10th
power” means 10 times itself 10 times, or 10,000,000,000. Multiplying this value by 9.88
gives you 98,800,000,000, an approximation of 98,765,432,198. Increasing the number of
decimal places (the only option available for this format) increases the precision and will
likely require a wider cell to accommodate the displayed value.

You can also use the Scientific format to display very small numbers. For example, in a
standard-width cell this format displays 0.000000009 as 9.00E-09, which equates to 9
times 10 to the negative 9th power. The expression “10 to the negative 9th power” means
1 divided by 10 to the 9th power, 1 divided by 10 nine times, or 0.000000001. Multiplying
this number by nine results in our original number, 0.000000009.
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Understanding the Text format

Applying the Text format to a cell indicates that the entry in the cell is to be treated as text,
even if it's a number. For example, a numeric value is ordinarily right-aligned in its cell. If
you apply the Text format to the cell, however, the value is left-aligned as if it were a text
entry. For all practical purposes, a numeric constant formatted as text is still considered a
number because Excel is capable of recognizing its numeric value anyway.

Using the Special formats

The four Special formats shown in Figure 9-40 are a result of many requests from users.
These generally noncalculated numbers include two ZIP code formats, a phone number
format (complete with the area code in parentheses), and a Social Security number format.
Using each of these Special formats, you can quickly type numbers without having to type
the punctuation characters.

Mumber Alignmentl Font |Border| Fill |Protection

Categony:
General Sample
Mumber 00123
Currency
Accounting Type:
Date

Time
Percentage
Fraction
Scientific

Zip Code

Zip Code = 4

Phone Number

Social Security Number

Texut

Custom

Locale [location):
|Eng|ish [United States)

Special formats are useful for tracking list and database values.

Figure 9-40 Excel provides several frequently requested formats in the Special category.

Chapter 9
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The following are guidelines for using the Special formats:

® Zip Code and Zip Code +4 Leading zeros are retained to correctly display the
code, as in 04321. In most other number formats, if you type 04321, Excel drops the
zero and displays 4321.

e Phone Number Excel applies parentheses around the area code and dashes
between the digits, making it much easier to type many numbers at the same time
because you don't have to move your hand from the keypad. Furthermore, the num-
bers you type remain numbers instead of becoming text entries, which they would be
if you typed parentheses or dashes in the cell.

e Social Security Number Excel places dashes after the third and fifth numbers. For
example, if you type 123456789, Excel displays 123-45-6789.

® Locale This drop-down list lets you select from more than 120 locations with
unique formats. For example, if you select Vietnamese, only two Special formats are
available: Metro Phone Number and Suburb Phone Number.

Creating Custom number formats

Most of the number formats you need are available through commands and buttons on
the ribbon, but you can use the Format Cells dialog box to accomplish minor feats of for-
matting that might surprise you. We'll use the Custom category on the Number tab in the
Format Cells dialog box, shown in Figure 9-41, to create custom number formats using spe-
cial formatting codes. (To quickly display the Format Cells dialog box, press Ctrl+1.) Excel
adds new formats to the bottom of the list of formatting codes in the Type list, which also
includes built-in formats. To delete a custom format, select the format in the Format Cells
dialog box, and click Delete. You cannot delete built-in formats.

Creating new number formats The quickest way to start creating a custom format is to
use one of the built-in formats as a starting point. Here's an easy way to build on an exist-
ing format, as well as to see what the codes in the Type list mean:

1. Type a number (or, in the case of our example, a date), and apply the built-in format
that most closely resembles the custom format you want to create. Leave this cell
selected.

2. On the Number tab in the Format Cells dialog box, select the Custom category. The
format you selected is highlighted in the Type list, representing the code equivalent
of the format you want to modify, as shown in Figure 9-41.
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